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Third-Party Software Acknowledgement

This document is intended to help users of Gemalto products when working with third-party software, such as
Office 365 ProPlus.

Material from third-party software is being used solely for the purpose of making instructions clear. Screen
images and content obtained from third-party software will be acknowledged as such.

Description

Remote access poses both a security and a compliance challenge to IT organizations. The ability to positively
identify users (often remote users) requesting access to resources is a critical consideration in achieving a
secure remote access solution. Deploying remote access solution without strong authentication is like putting
your sensitive data in a vault (the datacenter), and leaving the key (user password) under the door mat.

A robust user authentication solution is required to screen access and provide proof-positive assurance that only
authorized users are allowed access.

PKIl is an effective strong authentication solution to the functional, security, and compliance requirements.

SafeNet Authentication Client (SAC) is a public key infrastructure (PKI) middleware that provides a secure
method for exchanging information based on public key cryptography, enabling trusted third-party verification of
user identities. SafeNet’s certificate-based tokens provide secure remote access, as well as other advanced
functions, in a single token, including digital signing, password management, network logon, and combined
physical/logical access.

The tokens come in different form factors, including USB tokens, smart cards, and software tokens. All of these
form factors are interfaced using a single middleware client, SafeNet Authentication Client (SAC). The SAC
generic integration with CAPI, CNG, and PKCS#11 security interfaces enables out-of-the-box interoperability
with a variety of security applications, offering secure web access, secure network logon, PC and data security,
and secure email. PKI keys and certificates can be created, stored, and used securely with the hardware or
software tokens.

SafeNet Authentication Manager (SAM) provides your organization with a comprehensive platform to manage
all of your authentication requirements, across the enterprise and the cloud, in a single, integrated system. SAM
enables management of the complete user authentication life cycle. SAM links tokens with users, organizational
rules, and security applications to allow streamlined handling of your organization's authentication infrastructure
with a flexible, extensible, and scalable management platform.

SAM is a comprehensive token management system. It is an out-of-the-box solution for Public Certificate
Authorities (CA) and enterprises to ease the administration of SafeNet’s hardware or software tokens devices.
SAM is designed and developed based on the best practices of managing PKI devices in common PKI
implementations. It offers robust yet easy to customize frameworks that meets different organizations’ PKI
devices management workflows and policies. Using SAM to manage tokens is not mandatory, but it is
recommended for enterprise organizations.

For more information, refer to the SafeNet Authentication Manager Administrator Guide.

Office 365 ProPlus is a productivity software (including Word, PowerPoint, Excel, Outlook, OneNote, Publisher,
Access, and Lync) that is installed on your desktop or laptop computer. It is a user-based service that allows
users to access Office experiences on up to five PCs or Macs, and on their mobile devices. Traditional Office
installations were tied to the computers they were installed on. Office 365 ProPlus enables flexible new
deployment options that IT and/or individual users can choose from to install Office.
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This document provides guidelines for deploying certificate-based authentication (CBA) for user authentication
to Office 365 ProPlus using SafeNet tokens.

It is assumed that the Office 365 ProPlus environment is already configured and working with static passwords
prior to implementing SafeNet multi-factor authentication.

Office 365 ProPlus can be configured to support multi-factor authentication in several modes. CBA will be used
for the purpose of working with SafeNet products.

Applicability

The information in this document applies to:

o SafeNet Authentication Client (SAC)—SafeNet Authentication Client is the middleware that manages
SafeNet's tokens.

Environment

The integration environment that was used in this document is based on the following software versions:
o SafeNet Authentication Client (SAC)—Version 9.0

e Office 365 ProPlus—Including the Office 365 account

e AD FS—On Windows Server® 2012 R2

Audience

This document is targeted to system administrators who are familiar with Office 365 ProPlus, and are interested
in adding multi-factor authentication capabilities using SafeNet tokens.

CBA Flow using SafeNet Authentication Client

The diagram below illustrates the flow of certificate-based authentication:

Authentication using SAC

- .

o~ —-——

1. A user attempts to log on to Office 365 ProPlus. The user is redirected to AD FS proxy server (WAP) for
authentication.
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After successful authentication, user is redirected to SafeNet Authentication Client (SAC) for a secondary
authentication. The user uses the SafeNet token on which his certificate resides, and, when prompted,
enters the token password.

The SAC authentication reply is sent back to AD FS, which returns a response to Office 365 ProPlus,
accepting or rejecting the user’s authentication request.

The user is granted or denied access to Office 365 ProPlus.

Prerequisites

Before implementing certificate-based authentication for Office 365 ProPlus using SafeNet tokens, ensure the
following:

To use CBA, the Microsoft Enterprise Certificate Authority must be installed and configured. In general, any
CA can be used. However, in this guide, integration is demonstrated using Microsoft CA.

If SAM is used to manage the tokens, Token Policy Object (TPO) should be configured with MS CA
Connector. For further details, refer to the section “Connector for Microsoft CA” in the SafeNet
Authentication Manager Administrator’s Guide.

Users must have a SafeNet token with an appropriate certificate enrolled on it.

SafeNet Authentication Client (9.0) should be installed on all client machines.

Supported Tokens in SafeNet Authentication Client

SafeNet Authentication Client (SAC) supports a number of tokens that can be used as a second authentication
factor for users who authenticate to Office 365 ProPlus.

SafeNet Authentication Client 9.0 (GA) supports the following tokens:

Certificate-based USB tokens

SafeNet eToken PRO Java 72K

SafeNet eToken PRO Anywhere

SafeNet eToken 5100/5105

SafeNet eToken 5200/5205

SafeNet eToken 5200/5205 HID and VSR

Smart Cards

SafeNet eToken PRO Smartcard 72K
SafeNet eToken 4100

Certificate-based Hybrid USB Tokens

SafeNet eToken 7300
SafeNet eToken 7300-HID
SafeNet eToken 7000 (SafeNet eToken NG-OTP)

Software Tokens

SafeNet eToken Virtual
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e SafeNet eToken Rescue

Configuring Office 365 ProPlus and AD FS

Configuring Office 365 ProPlus and AD FS requires the following:

e Enabling Office 365 Federated Domains, page 7

e Configuring the AD FS Authentication Policy, page 8

¢ Downloading and Installing Office 365 ProPlus, page 10

e Enabling Modern Authentication for Office 365 ProPlus, page 11

Enabling Office 365 Federated Domains

1. Logintothe AD FS server machine as a domain administrator.

2. Open Windows Azure AD Module for Windows PowerShell.

3. Atthe command prompt, type Connect-MsolService, and then press Enter.
4

On the Enter Credentials window, enter your Azure AD administrator username and password, and then
click OK.

£ Administrator: Windows Azure Active Directory Module for Windows PowerShellL= | 9| X

S Ci\Ugers\Adninistrator\Desktop?> Connect-MsolService

Enter Credentials

Please enter credentals

\ser name: L #

Password LT T

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)

SafeNet Authentication Client: Integration Guide

Using SafeNet Authentication Client CBA for Office 365 ProPlus
Document PN: 007-013447-001, Rev. A, Copyright © 2016 Gemalto, Inc., All rights reserved.



5. Atthe command prompt, perform the following steps:
a. Type Set-MsolADFSContext —Computer <AD FS machine name>, and then press Enter.

b. Type Convert-MsolDomainToFederated -DomainName <your domain name>, and then press
Enter.

4 Administrator: Windows Azure Active Directory Module for Windows PowerSheIIlL'i-_

S C:\UsersNadministrator.SFNITDEMO\Desktop> Connect—MsolService

S C:\UsersNadministrator.SFNTDEMO\Desktop> Set—MsolADFSContext —Computer ad.sfn
demo.com

S C:\UsersNadministrator.SFNITDEMO\Desktop> Convert—MsolDomainToFederated —Domai
Name sfntdemo.com

Successfully updated ’sfntdemo.com’ domain.
S C:\UsersNadministrator.SFNITDEMO\Desktop>

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)

6. Open the ADFS Management console.

7. Inthe left pane, under Console Root, click AD FS > Trust Relationships > Relying Party Trusts.
In the right pane, Microsoft Office 365 Identity Platform should be listed as a trust.

Console Root Display Name Enabled Type Kertiier

4 ADFS Device Ragistration Service Yes WS-T.. unms<drssasd: safenstiemos.com
b Service Microsoft Offica 365 Identty Fiatform Yas WS-T,. unfederaton:McrosoftCriine
4 Trust Relationzhipz

Claims Provider Trusts
Relying Party Trusts
Attribute Stores

a Authentication Polcies

Per Relying Party Trust

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)

Configuring the AD FS Authentication Policy

1. Onthe AD FS Management console, in the left pane, under AD FS, click Authentication Policies.
2. Inthe right pane, click Edit Global Primary Authentication.

1ADFS Authentication Policies Actions
3 Service e N
b 01 Trust Relationships Authentication Policies Overview Authentication Policies
4| Authentication Policies [ Eait Global Primary Authentication... |
Per Relying Party Trust ‘You can configure primary authentication and multiactor authentication settings globally of per relying party trust Tait Global Mult-factor Authentican,
Learn More

View »
Configuiing Authentication Palicies

New Window from Here
AD FS Help

G Refresh
. . . Hel
Primary Authentication B e

Primary authentication is required for all users tying to access applications that use AD FS for authentication, You can use options below to configure
global and custom primary authentication settings.

Global Settings
Authentication Methods ~ Extranet Forms Authentication Edit
Intranet Forms Authentication
Device Authentication Not enabled
Custom Settings
Per Relying Party Manage
Web Application Proxy Edit

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)
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3. Onthe Edit Global Authentication Policy window, on the Primary tab, ensure that Forms Authentication
is selected for both Extranet and Intranet.

Edit Global Authentication Policy =]
Prenary | Mol factor

Select sutherbcston methods. By selecting more than one suthentication method, you enable
wsens 10 have a choce of what method to sutherticate vth ot sign in

¥ Integrated Windows autherticaton method i spechied. & appears as the delaut
subericaton method on browsees that support Integrated Windows autherbcaton

Extranet

" Foomg Autherhcaton
Certfcale Auterhcson

Iricaret

! Foma Auhentication
Windows Autherbicaton
Certicate Autherbcston

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)

W NOTE: If you want to use CBA as the only authentication mechanism, ensure
that only Certificate Authentication is selected for both Extranet and Intranet.
Refer to “Appendix B: Configuring AD FS with CBA for Single Authentication” on
page 18.

4. On the Multi-factor tab, perform the following steps:
a. Under Users/Groups, add users and/or groups for which MFA will be required.
b. Under Locations, select Extranet and/or Intranet, according to your preferred configuration.
c. Select Certificate Authentication as an additional authentication method.
d. Click OK.

Edit Global Authentication Policy .

[Pamay| Molifocor |

Configure muttifactor authentication (MFA) settings.
Users/Groups
MFA s required for the following users and groups:
SFNTDEMO\Domain Users

Devices

MFA is required for the following devices:

[[] Unregistered devices

[] Registered devices

Locations

MFA is required when accessing applications from the following locations:
Extranet

Intranet

Select additional authentication methods. You must select at least one of the following methods
to enable MFA:

[ Cetficate Authertication
|

What is multifactor authentication?

T |

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)
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Downloading and Installing Office 365 ProPlus

1. Log in to your Office 365 account.

2. On the Office 365 account console, under Install Office on more devices, click Install.

Office 365

Collaborate with Office Online

Let your ideas

go free.

Install Office on more devices

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)

3. Click Install to download the installation file of Office 365 ProPlus.

COMPLTER NANE CPERATING SYSTIM ISTALLATION DAY

EEEN NN

0 a

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)
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4. Double-click the downloaded file to start the installation process.

Setup.X86.¢e...

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)

Enabling Modern Authentication for Office 365 ProPlus

To enable modern authentication on a Windows machine that has Office ProPlus installed on it, set the following
registry keys:

Registry Key Type Value
HKCU\SOFTWARE\WMicrosoft\Office\15.0\Common\ldentity\EnableADAL REG_DWORD 1
HKCU\SOFTWARE\Microsoft\Office\15.0\Common\ldentity\Version REG_DWORD 1

HKCU\SOFTWARE\Microsoft\Office\15.0\Common\ldentity\Debug\TCOTrace REG_DWORD 3

After you have set the registry keys, you can set Office 2013 devices apps to use MFA with Office 365.

Running the Solution

Signing In to Outlook 2013

1. Double-click the Outlook 2013 icon.

2]

Outlook 2013

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)

2. Outlook 2013 is launched. Click the File tab.

BE oS- Inbox - - Outlook 7@ - 8 X
HOME SEND / RECEIVE FOLDER VIEW
= "_"j y : v 5 . Siah:h People %
. % Clean Up ~ | “ERules~ [ Address Book ;
New New o lete | F ly For 1 EJ Team Email = . 3 ; Send/Receive
Email ltems~ o Junk - \ Y Fiter Email " ) Folders
New Delete Respond Quick Steps ] Move Tags Find Send/Receive ~
Search Current Mailbox (Ctrl~E} P |-
All Unread ByDate ~  Newest ¢

We didn't find anything to show here.

All Folders  Inbox

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)
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https://support.office.com/en-us/article/multifactor-authentication-MFA-8f0454b2-f51a-4d9c-bcde-2c48e41621c6

3. Inthe left pane, click Office Account. Then, in the right pane, click Sign In to sign in to your Office 365

account.

©

Info

Open & Export

Office Account

Options

Exit

Inbox -

Account

Office Theme:
White

Sign in to Office

Get to your documents from anywhere by signing in to

Office. Your experience just gets better and more

personalized on every device you use.

SignIn

- Outlook e

Product Information

] Office

Subscription Product
Microsoft Office 365 ProPlus

This product contains

FRBFREPED®

Manage Account

Office Updates
¥l 2

Updates are automatically downloaded and installed.

Update

Version: 15.0.4701.1002
Options ~

Q About Outlook

Learn more about Outlook, Support, Product ID, and
About Copyright information.
Outlook

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)

4. On the Sign in window, enter your AD user name (for example, Bob@sfntcloud.com), and then click Next.

Sign in
use with Office

Type your emad address

When you sign in

Type the email address of the account you would like to

X

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)
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5. You will be redirected to your organization’s login window. Enter your AD password, and then click Sign in.

x
dc.sfntcloud.com

Sign in with your organizational account

Bob@sintcloud.com

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)

6. After successful login, the browser displays all the certificates available on the machine. Select the end user
certificate that is added on the SafeNet USB token.

7. You will be redirected to the Confirm Certificate window. Click OK.

Windows Security @
Confirm Certificate

Confirm this certificate by clicking OK. If this is not the correct certificate,
click Cancel.

‘=i bob
‘ Issuer: sfntdemo-AD-CA

Valid From: 10/21/2015 to 10/20/2016
\

iClick here to view certificate prope...:

[ OK ] [ Cancel

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)
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8. On the SafeNet Authentication Client login window, enter the token password, and then click OK.

|

.‘ (s) Token Logon -
@afeNet. SafeNet Authentication Client 15 418 (IR

Enter the Token Password

Token Name: My Token

Token Password: |

Current Language: EN
This is an unlicensed copy for evaluation use only.

0K Cancel

After successful authentication, you will be logged in to your Outlook 2013 account.

Inbox - - Outlook ? - 8 X

Account

Bob@sftcloud.com Product Information

Sign out

1] Office

Office Background:

Subscription Product
Office Account Office Theme: Microsoft Office 365 ProPlus

White - This product contains

Qptides FONDPRREPED®
o Connected Services: Manage Account
it
CAN'T DISPLAY ONLINE SERVICES .
Sorry, we had a server issue and can't display your %] Office Updates
e e [ Updates are automatically downloaded and installed.
Update Version: 15.0.4701.1002
Try again Options ~

Add a service -
Q About Outlook
Learn more about Outlook, Support, Product ID, and

About Copyright information.
Outlook

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)

Signing In to OneDrive for Business 2013

1. Double-click the OneDrive for Business 2013 icon.

&

OneDrive for
Business 2013

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)
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2. Onthe Microsoft OneDrive for Business window, enter the SharePoint URL provided by the administrator
(refer to “Appendix A: Obtaining the Office365 SharePoint URL” on page 17 for details on how to obtain this
URL), and then click Sync Now.

#& Microsoft OneDrive for Business =) félh‘

Which library do you want to sync?

https://sfntdemo.sharepoint.com
You'll find your documents under Favorites in Windows Explorer.

We'll save the library here:
C\Users\User
Change

[ Sync Now ] [ Cancel }

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)

3. On the Sign in window, enter your AD user name (for example, Bob@sfntcloud.com), and then click Next.

Sign in

Call us overprotective, but we need to verify your
account again before ope

https://sfntdemo.sharepoint.com”.

[Type your email address

Next

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)

4. You will be redirected to your organization’s login window. Enter your AD password, and then click Sign in.

dc.sfntcloud.com

Sign in with your organizational account

Bob@sintcloud.com

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)
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5. After successful login, the browser displays all the certificates available on the machine. Select the end user

certificate that is added on the SafeNet USB token.

6. You will be redirected to the Confirm Certificate window. Click OK.

Windows Security @
Confirm Certificate

Confirm this certificate by clicking OK. If this is not the correct certificate,
click Cancel.

==am) bob
‘ Issuer: sfntdemo-AD-CA

Valid From: 10/21/2015 to 10/20/2016
|

iClick here to view certificate prope...:

[ ok ][ cance

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)

7. Onthe SafeNet Authentication Client login window, enter the token password, and then click OK.

@ Token Logon =
@afeNet. SafeNet Authentication Client oo

=

Enter the Token Password

Token Name: My Token

Token Password: |

Current Language: EN
This is an unlicensed copy for evaluation use only.

OK Cancel

8. After successful authentication, you will be logged in to the OneDrive for Business 2013. Select the folder

you want to sync, and then click Sync selected.

& Microsoft OneDrive for Business [

Select the library you want to sync
We found multiple libraries for the site you specified, Select the one you want to sync

MName

sgnummo] | cancel

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)
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After the synchronization process is started, a message is displayed.

#& Microsoft OneDrive for Business = | & @

Your files are syncing as we speak. Go take a look
and watch them come in.

You can see your files here:
C\Users\User\SharePoint\SharePoint Document Library

Show my files...

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)

A message is displayed adjacent to the OneDrive for Business 2013 icon in the system tray to indicate
that the synchronization process is running.

OneDrive for Business e .
You can always see the status of your synced files here...

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)

Appendix A: Obtaining the Office365 SharePoint URL

1. Log into Office365 as an administrator.

2. On the Office365 console, in the left pane, click Admin > SharePoint.

a
\Y
i

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)
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In the right pane, the Office 365 SharePoint URLs are listed.

Office 365 Admin

» 17.47 GB available of 20.45 GB Wl 1600 resources available Bl
URL STORAGE USED (GB) STORAGE QUOTA (GB) PERCENT USED SERVER RESOURCE QUOTA VERSION

harepoint.com 0.00 300

o-public.sharepoint 0.12 0.98 270 % 0 2013

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)

Appendix B: Configuring AD FS with CBA for Single
Authentication

1. Onthe AD FS Management console, in the left pane, under AD FS, click Authentication Policies.
2. Inthe right pane, click Edit Global Primary Authentication.

TADFS Authentication Policies Actions
b [ Service e = =
N i i ; Authentication Policies A
b 7 Trust Relationships Authentication Policies Overview
[ B S reieEan oo Edit Global Primary Authentication...
| Per Relying Party Trust ‘You can configure primary authentication and mulifactor authentication settings globally or per relying party trust.

Edit Global Multi-factor Authentica...
Learn More View »
Configuring Authentication Policies

New Window from Here
ADFS Help

@ Refresh
. . . Hel,
Primary Authentication @ nep

Primary authentication is required for all users tiying to access applications that use AD FS for authentication. You can use options below to configure
global and custom primary authentication settings.

Global Settings

Authentication Methods ~ Extranet Forms Authentication Edit
Intranet Forms Authentication
Device Authentication Not enabled

Custom Settings
Per Reing Party Manage
‘Web Application Proxy Edit

Multi-factor Authentication

You can use options below to configure mulifactor ication seltings based on ps, device, and location data. Multifactor
authentication is required i there is  match for any of the specified requirements.

Global Settings

Requirements Users/Groups ot configured Edit
Device Not configured
Location Not configured
Authentication Methods S afeNet MuliFactor Authentication (SMFA)
Custom Settings
Per Relying Party Manage
Web Application Praxy Edit

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)
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3. Onthe Edit Global Authentication Policy window, on the Primary tab, ensure that Certificate
Authentication is selected for both Extranet and Intranet.

[ P [

Edit Global Authentication Policy -

Exranet

Select authentication methods. By selecting more than one authentication method, you enable
users to have a choice of what method to authenticate with at sign in.

If Integrated Windows authentication method is specified. it appears as the default
authentication method on browsers that support Integrated Windows authentication.

[j Forms Authentication

|
T Cerficate Autherticaton |

Intranet

|["] Forms Authentication

%] Certificate

[] Windows Authertication

(The screen image above is from Microsoft® software. Trademarks are the property of their respective owners.)

Support Contacts

If you encounter a problem while installing, registering, or operating this product, please make sure that you
have read the documentation. If you cannot resolve the issue, contact your supplier or Gemalto Customer
Support. Gemalto Customer Support operates 24 hours a day, 7 days a week. Your level of access to this
service is governed by the support plan arrangements made between Gemalto and your organization. Please
consult this support plan for further information about your entitlements, including the hours when telephone
support is available to you.

Contact Method

Address

Phone

Technical Support
Customer Portal

Contact Information

Gemalto, Inc.
4690 Millennium Drive
Belcamp, Maryland 21017 USA

United States 1-800-545-6608
International 1-410-931-7520

https://serviceportal.safenet-inc.com

Existing customers with a Technical Support Customer Portal account can log in to
manage incidents, get the latest software upgrades, and access the Gemalto Knowledge
Base.
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